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1. Simulink To Signal Ranger Converter Description

1.1 Overview

The software SimulinkToSR Converter now allows you to easily implement graphical
MatLab/Simulink design onto a Signal Ranger DSP board (SR1) or the more recent

Signal Ranger MK2 board (SR2). Once you have completed your controller under

Simulink, you can convert and implement your design within a few simple clicks.

1.1 Features SIMU _JINK

Dynamic System Simulation for MATLAB

¢ Code conversion from MatLab/Simulink to
Signal Ranger DSP board.

¢ Simple user interface: convert, load &
execute on DSP, read and write on DSP.

+ Modifications of user defined variables
through the interface in real time.

1.2 Applications

¢ Motor controller
¢ General multi-channels controller
¢ Modern control
¢ Signal processing on audio signal

¢ ...

1.3 Requirements

¢ Signal Ranger DSP board (SR1) or Signal Ranger MK2 board (SR2)' by SoftdB?

¢ MatWorks R13 (MatLab 6.5) or MatWorks R14 (MatLab 7.0), including Simulink
and Real-time Workshop®

¢ Code Composer Studio software* by Texax Instruments.

' A SR2_Analog expansion board is also required in order to access a maximum of 16 analog 1Os.
2 Refer to www.softdb.com for more details about the Signal Ranger DSP board and other products.

® SimulinkToSR Converter has been tested under MATLAB version 6.5(R13), 6.5.1(R13SP1),
7.0.1(R14SP1) and 7.0.4(R14SP2).

* SimulinkToSR Converter has been developed under Code Composer Studio version 2, version 3.3 and
version 4 (see Annexe A on How to get Code Composer Studio).
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¢ Windows 2000 or newer

1.4 Software Installation

Download the software installer from www.softdb.com/dsp-products-simulink.php

1-  Run the self-extracting executable file SimulinkToSRX_Installer_vX.exe
2- Follow the installer instructions

You should now have access to the program from a shortcut in Start Menu-> Programs->
SimulinkToSR-> SimulinkToSRX. The current software documentation can also be accessed from the
same location.

The executable file is installed by default in \Program Files\SimulinkToSRX\. Moreover, the working
directory of the application is \ProgramData\SimulinkToSRX\. In this directory, you can find the
documentation file, this example directory as well as the IncludeSources directory. The IncludeSources
directory will eventually contain copies of the files from a third party protected by copyrightss.

1.5 Demo version limitations

The demo version of the software is provided as a 3-month trial period. Once this trial completed, we
invite you to contact Softdb for a program upgrade.

Most of the main Simulink blocks are already supported by our application. Consult the Annexe B for the
list of the blocks tested so far with the SimulinkToSR converter. At this moment, blocks with continuous
time are not supported. Other non-enumerated blocks are not guaranteed to work.

For the DSP on the Signal Ranger board, the code size is limited 32 Kbytes for SR1 board and 64 Kbytes
for SR2 board. At the time of the compilation, our converter will present a linking error if the code size is
too large. In such a case, you would have to reduce the size of your controller, but it’s possible to achieve
a relatively complex controller before you reach the limit.

Up to 100 MIPS (Millions of instructions per second) are allowed on SR1 board and up to 300 MIPS on
SR2 board. Following the complexity of the Simulink diagram and the sampling frequency used, you can
meet computation time limits of the DSP. To help you in this matter, the SimulinkToSR interface displays
the timing requirements in the upper left. Obviously, your application becomes critical when “Time usage”
approach 100% and will crash as it goes over.

1.6 Credits

This project has been initiated at the Université de Sherbrooke for a project of speciality by the following
students: Mathieu Hamel and Frangois Gagnon. They demonstrated the functionality of the concept and
they established the base of the current software. Soft dB owes them special thanks.

® See the 2.2.1.1 section on Required files for more details
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2. Implementing Simulink design on Signal Ranger DSP
The program developed by SoftdB takes advantage of the Real-Time Workshop utility available in
Simulink. The implementation process from Simulink to the DSP then goes in two distinct parts:

2.1 Creation of Simulink model

2.2 Conversion and implementation with SimulinkToSR interface

2.1 Creation of Simulink model

To facilitate the setup of Simulink model, we provide you a simple example that is already configure to
build a model with Real-Time Workshop. We suggest you to begin your design from the example located
in the “example” directory. It includes 4 files that you can copy and rename as needed (except for
grt_rtw_info_hook.m that have to keep the same name):

example.mdl : the pre-configured Simulink file
example_init.m : the file that initiates variables
example_sim.m : the simulation file (optional)

grt_rtw_info_hook.m: Real-Time Workshop needs that file to generate the model in relation to the
information specific to the DSP. This file has to be present in the same directory
as the Simulink file.

With Simulink, there are 4 main steps to convert Simulink design into DSP code.
2.1.1 Configure your simulink file
2.1.2 Design your system under Simulink
2.1.3 Predefine Simulink variables in MatLab workspace
2.1.4 Simulate your system
2.1.5 Build model with Real-Time Workshop

2.1.1 Configure your simulink file
If you are starting from the example.mdl (or a copy), go directly to the next subsection.

Note that unless mentioned otherwise, the default simulation parameters of simulink are used.

L] Configuration Parameters: example/Configuration

Select Simulation time.
Solver ! Stattime: 0 Stop time:|10000°T s
Diata Import/Export
Optimization
= Diagnastics
S ampls Time Type: Fired step | Solver diserete (o confinuaus states) v
Diata Integrity
Conversion
Connectivity
Compatibilty Tasking mode for periadic sample fimes: | Auto v
Model Referencing
Hardware Implementation
Model Referencing
= Fieal Time Workshop
Comments
Symbals
Custom Code
Debug
Interface

Solver options

Periodic: sample time constraint: Uncons traines d 4

Firedhstep size (fundamental sample timel: Ts

[] Higher pricrity value indicates higher task pricrity

[[] Automatically handle data ransfers between tasks

[ ok [ Conesl [ He Apply

Figure 1: Setting Solver options in Simulink
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From your Simulink file, go to Simulation-> Configuration Parameters-> Solver.

Simulation time parameters can be useful if you want to simulate your system inside Simulink, but are not
relevant for now.

In the Solver options section, select the type “Fixed-step” and the solver “discrete(no continuous states)”.
Also set the Fixed step size to the sample time you want to use. We suggest always using the variable
“Ts” which have to be previously defined in MatLab workspace (see 2.1.3 section).

With the SR1 board, the sampling frequency is restrained to Fs = 21700/N, where N = {1, 2, 3, ..., 32}.
With the SR2 board, the are many possible values from 286.102 Hz to 24414.062 Hz (the list is available
in Annexe C).

Knowing the Fs value, “Fixed step size” can be fixed to Ts = 1/Fs.

B Confi ion P. £ plefConfi i
Select: Simulation and cade generation
Sover Black reduction optimization Conditional input branch execution
Data Import/Export
i Implement logic signals a3 boolean data [vs, double), [] Signal storage reuse

< Disgmstcs i

Sample Time o :
Data Integity Application lifespan [days] inf
Conversion
Connectivity Code generation
Compatisity Signals
Hods| Refeiencing Erie o D ol pte e e
Hardware Implementation
Mokl Helerbraing Ignors integer downcasts in folded sxprassions [ Inline invariant signals
i PleakTimne Woikshop Eliminale supeiluous lemporaiy variables (Expression folding)

Loop unvaling thieshold: 5

Integer and fixed-paint

[] Remove cods fiom floaling-paint to integer conwersions that wraps out-of-range values

[ oK J[ Cancel “ Help Apply

Figure 2: Enabling Inline Parameters

Go to Simulation-> Configuration Parameters-> Optimization.

In the Simulation and code generation section, enable Inline parameters.

w Configuration Parameters: example /Configuration
Selact Target selection
POl System target fle: . Ho
Data Import/E sport
Optirizatior Language: c 2
= Diagnostics Descriptiorn
Sample Time
Dats Integrity Documentation
Convarsion [] Generate HTML report
Cannectivity

Compativity Launch report after code generation completes

Model Referencing

Hardware Implementation |~ 010 PrO5ess
Mordel Fefororiing TLE options
= Feaime #aishon 7 Make command: make_ttw
g;;';"jgls Ternplates makefile: ort_dsfoul_trmf
Cluste Ciodls
Debug Generate code only ———
Interiace [Benerae core

[ ok [ Conesl [ Hep | aeew

Figure 3: Setting Real-time Workshop options

Go to Simulation> Configuration Parameters-> Real-Time Workshop.

Enable Generate code only.
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2.1.2 Design your system under Simulink
Use Simulink help as needed if you are not familiar with the software.

Consult the list in the Annexe B, to know which blocks are so far supported by the current version of the
SimulinkToSR converter.

Note that input and output amplitudes in Simulink directly represent voltage amplitudes found on the
board IOs. Also, you should know that the analogue dynamic ranges are normally of +/- 10 volts for the
inputs and +/- 2 volts for the outputs. All values over those ranges will saturate to their maximal value on
the board.

Let’'s now explore different possibilities through different block types used in the example.mdl file.

T L}
el i =i 1
input 1 bl p_g2in output1 "I:I
loop_input n Out1
Gaint
DC_am <] T L
[ooom | [ | ]
Drata Stare Memany [rata Store Read nuez
4+ o+
' ' ' ' :: E] z
' ' ' ' outputs
++ +++ + (] Outs
Pulze
Fenerator
- o FFF Seope
JR— +
outputs +-.- - l/_ =; 4 E
[ — + + sine_wawe _/l output
- 2 +4t l:l Clutd
[ata Store Sine Mave Saturation
tlemony
Seope
mukt_result

P

[U'Q:I bl atri
atre o 1

e Multiphy R UGR.C) L S

Constantl Constant2 - O ————— Ou5

Fraduct
0.29 1.02 T b
1 ] e ]

[ 1] [ 3 =

1.2|I [ 755 | 755

¥y

matrizc Constantd Dizplay [ ata Store
- - Mirite
Constantz Dizplay3 Dizplay
[]

T T

—_ —_ delay_zero-delay_pole

z1 z1

Discrete-Time Discrete-Time -
Integrator Inv glator1 Gaing
1 1
- delay_pale -
z =
. d Unit Delay [] a Unit Delayl
Zain3 i
ain 17zer0s(z) Faing
2 input2 > outputy? L' i
compenzater igput polesz) Qut?
Dizcrete
Zero-Pole
» numiz) #:EI
outputs
deniz) Cutd

Discrete
Transfer Fen

Figure 4: Example Simulink file, Example.mdl

If the number of Inport and Outport in the Simulink design exceeds the physical number of analog 10s on
the board, the processor will still process the operations related to a virtual 10. Also, port numbers of
Inport and Outport blocks are directly related, in ascending order, to the available IOs of the board.

The Simulink example showed in figure 4 illustrates a variety of blocks and configurations. The first port is
in loopback, so unity loop_gain should result in an analogue output of same voltage as the input. DC,
pulse and sinusoid sources are send to outputs 2, 3 and 4 respectively. Matrix operations are used to
send a value to output 5. Finally, three different ways to compute a phase compensator are used for
outputs 6, 7 and 8.
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®¥ Source Block Parameters: Sine Wave W Function Block Parameters: Discrete Zero-Pole
Sine Wave

Output a sine wave:
0t] = Amp*Sin[Freq't+Phase] + Bias

Sine type determines the computational technique uzed. The parameters in the two
types are related through:

Samples per period = 2°pi # [Frequency * 5 ample time]
MHumber of offzet samples = Phase ™ Samples per penod /7 [27pi]

Use the sample-bazed zine tppe if numerical problems due ta running for large times
[e.q. overflow in absolute time] occur.

Parameters
Sine type: | Sample based

Time [t]:| Use simulation time
Amplitude:

sihe_amp

Bias

1]

Samples per period:

sine_per

MNumber of offset samples:

1]

Sample time
Ts

Interpret vector parameters az 1-0

Discrete Zero-Pole

M atrix expression for zeros. Wector expression for pales and gain. Output width equals
the number of columns in 2eros matriz, or one if 2eroz is a vector.

| State properties
Zeros:
zer0s
Pales:
poles
Gair;

1

Sample time [-1 far inherited):
-1

[ ok J[ cancel | Heb | ey

I ag H Cancel H Help ]

Figure 5: Setting Sine Wave parameters

Figure 6: Setting Discrete Zero-Pole
parameters

When the Sample Time parameter is present in block parameters, you should assign its value to the
same as the Fixed step size set in previous subsection (figure 5). When it is mentioned beside the
parameter, you can alternatively set its value to “-1” for inherited (figure 6).

As seen in the examples, several parameters are set symbolically through variables. We will later see that
it is possible to modify most of block parameters dynamically once the program is implementede. To do
s0, use variable names instead of numbers, vectors or matrixes. Of course, those variables have to be
previously defined in MatLab workspace (see next subsection).

2.1.3 Predefine Simulink variables in MatLab workspace

All variables assigned to Simulink parameters must be declared before Simulink can use them. To ease

the process, you should use a M-file” as an initiation file.

For now, you can look the example_init.m as an example.

® If for some reason, some parameters cannot be modified in real-time, Real-Time Workshop usually
mentions it when it builds the model. Moreover, those parameters won’t be accessible through the

SimulinkToSR interface.

’ For MatLab neophytes, a M-file is a file in which you can write MatLab code and then call it in MatLab.

You can create one from MatLab—>new—>M-file.
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O

= &

1 R R TEETEETEEEEE EE  ER E E E E EE EAE E E E E RE ER N R TR N RS TR RN RS R RN e N %Y |f;
2 3 edample init.m
3 R R e e e e it e L Lt
4 % File that initiates the user defined wvarisbles used in the example.mdl
5 % SBimulink file. This init file is intended for both 3R1 and 3R2 board.
3 % By default, the parameter of frequency Fs is set for 3R1 while the
7 % -paErameteE. af Fs et SR2: 18 1n comment:
g R e e e R e e e e e e
9 % By SoftdB, june 6th 2006
10 SRR R R R R R R R R N R R R RN R R R R E N RN RN RN RN R RN Ry
11
1z R R R R e e e e R i ]
13 F SELECT HERE THE SAMPLING PERIODL Ts that should bhe used for the "fixed step size™
14 % paraweter set in SIMULIMNE-->Simulation--rConfiguration Parawmeters—-->5olwver
15 % and that should also be used for every hlock sawple time =
16 RS R R R R R R R R R R R R R R T R R R R R R SR R R R RS
Ak Soemable- Fs of SRl e Fsief SR lhelar
15
19 % For SR1 board:
Z0 - MN=zg; % Zelect one of the restrained wvalue of N={1,2,3,...,32}
e e F==N/21700; % Resulting Simalink sampling period (seconde)
22
23 3 'For -3R& board:
24 3F3=532.2958; % Select a freguency allowed by 3RE hoard
25 % You may set the aimed frequency atnd SimulinkTolR converter
26 % will prowvide you the closest fregquency allowed.
27 RS R R R R R R R R R R R A R A R SR R R R RS
28 % Besulting 3imulink sampling period (seconde). One of the Fs abowve must be uncommented.
29 - T==1/F=;
SIEL SRR R I I R R N R T R I R TR I R R R R IR RS R R EE %Y
il EEEESEEEEEREYEE Definitions of wariasbles used in Simulink file EEEES RS RETEEREESES
o3| | = loop gain = 1; % defsult loopback gain on the first AIC
S (= f sine = 1.0} % fregquency (hertz) Lfor the sinusoid
S o sine amp = 1; % Default sinusoid awplicude [(wolts)
35 - sine per = round(1l/(Ts*f_sine)):% Default sinuscid period (sawples), frequency(Hz)=1/(Ts*sin per)
S5 = pulse_ atp i % Default pulse amplitude (volts)
i i pulse per = sine_ per:; % Default pulse period (samples), frequency(Hz]=1f(Ts*pulse_perj
i pulse width = rDund(pulse_perﬁZJ;% Default pulse width (samples), DutyCycle=pulse_width£pulse_per
39 - matrix = [1.1 1.2]: % Matrix 1 by 2 iv
!(] 111l | [}J"m
| script [n 13 co 1 [ovk

Figure 7: Examp
Note that the prev

le initiation M-File, example_init.m

iously used sampling period “Ts” is defined in this initialization file. Its value is set

through the constant “N” which suggested values should be respected.

Once you are done writing your M-file, execute it in MatLab®. If you forget to declare some variables the
simulation or the Real-time Workshop builder will further detect it.

2.1.4 Export Variables

With the Signal Ranger DSP board, it is possible to communicate with DSP while the code is running. It is
then possible to read and write dynamically parameters called "ExportedGlobal" in your Simulink model.

This feature gives t

There are three wa

he designer great flexibility.

ys to access user variables:

® The easiest way to execute a M-file is by pressing “F5”. You can alternatively set the “Current
Directory” parameter in MatLab to your M-file directory and then enter your M-file name (without

extension) in the

Command Window.
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2.1.4.1 Predefined variables

You can access dynamically the symbolic Simulink parameters set with variables in Matlab workspace
(see previous subsection). However, you have to specify which variables have to be exported. Indeed, all
variables you want to access in real-time have to be configured "ExportedGlobal” in Simulink.

A\ Mode| Parameter Co nfiguration: example g@
Description
[refine the global (tunable) parameters far your madel. These parameters affect:
1. the simulation by providing the ability to tune parameters during execution, and
2. the generated code by enabling access to parameters by other modules.
Source list Glahal {tunahle) parameters
MATLAB warkspace A Mame Storage class Storage type qualifier ™
1 DC_amp ExportedGlohal w “
MHarme =
= 2 adv_pole ExportedGlohal w “
1 DC_am =
—Ame 3 ady zerg | EPOMEdGIoba] v v
2N =
4 column sy EportedGlobal w w
3Ts =
B : 5 delay_polé ExporntedGlohal w w
adv_pole =
-f 6 delay_zerd EXpOTEdGIobal v v
5 ady_zero =
7 den ExportedGlohal w -
B column_selectar
8 laop_gain ExpontedGlohal W i
T delay_pole =
9 matrix ExportedGlohal w v
8 delay_zero
Y 1onum | ExportedGlobal v v
9den ——
SimulinkGlohal {Auta) w
) 11 poles
tdnnn mEin = ——— | EvportedGlobal =
Refrash list Importe}Sytern Mew l [ Remave ]
Impone&(_\%mPointer
N
Ready [ QK ] [ Cancel ] [ Help ] [ Apply ]

Figure 8: Set variables "ExportedGlobal”

To do so:

1- From your Simulink file, go to Simulation> Configuration Parameters-> Optimization>
Configure. All variables found in MatLab workspace are enumerated in the Source list (figure 8).

2- Select the variables you wish to access through the SimulinkToSR interface and press add fo
table>>. The added variables then appear in Global (tunable) parameters.

3- Set the Storage class of all the added variables to “ExportedGlobal” and press OK to confirm.

This works only if the variable is actually used somewhere as a parameter of your system. Moreover,
some variables will be ignored if Simulink does not allow a particular parameter to be dynamic.

2.1.4.2 Data Store blocks

The Simulink blocks Data Store Memory, Data Store Read and Data Store Write allow you to respectively
declare, read and write a data variable. Simply set the RTW Storage Class parameter of the Data Store
Memory block to "ExportedGlobal" to give a dynamic access through the interface (figure 9).

p.8
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®/Block Parameters: Data Store Memory

[rataStoretdermary

B/ Source Block Parameters: loop_input

Define a memory region for uge by the Data Store Read and Data Store ‘Wiite blocks.
All Read and ‘white blacks that are in the curent [sub)system level or below and have Inport

th data st ill be able to read fi ite ta this block. . . . .
e e Pravide an input port for a subsyster or model. For Triggered Subsystems, if 'Latch

[buffer] input' is selected, then the Inport block produces the walue of the input at the
Data Types previous time step. The other parameters can be used to explicitly specify the input
signal attributes.

ata store name: |DC_amp

Cormresponding Data Store ReadM¥rite blocks: 1efresh Main | Signal specification
example/Dats Store Read ,
Part number:
1
lcon display: | Port number |»

Latch [buffer] input:
Interpolate data

Initial value: |1

[[] Data store name must rezolve to Simulink signal object

RT' storage clazs: | ExportedGlobal v
RT' type qualifier:

Interpret vector parameters as 1-00

I Ok l ’ LCancel ] ’ Help ] Apply

o e )]

Figure 9: Exporting DataStoreMemory for DC_amp Figure 10: Exporting Wire Probe for inputi

2.1.4.3 Wire Probes

The use of a probe on a wire allows you to read (only) its value through the interface. To do so, right-click on
the wire, select "Signal Properties..." and set the RTW Storage Class parameter to "ExportedGlobal" (figure 10).
Avoid setting ExportedGlobal wires going to Outport block especially if you are using MATLAB 7.0(R14)
because it may cause the Real-Time Workshop to ignore assignment to Outport (this issue was not fixed yet in
R14SP2).

2.1.5 Simulate your system

Simulations are obviously not necessary, but it's usually much simpler to debug your system under the
MatWorks environment than once the program implemented on the DSP. The present document is not really
intended to show you how to simulated, but let’s quickly see what are the options.

One way to do your simulation is to use the tools directly in Simulink. As in the example, you can place Scope
and Display blocks on the signals of interest. Afterwards, you can start the simulation by going to Simulation->

Start (or start icon 4 ).

One more flexible way is to insert the model in a M-file that will simulate it. You can then simulate the system
inputs and plot the outputs among other things.

To incorporate you Simulink mode into a M-File, you need to use the “sim” MatLab function. Its main input
parameters are the Simulink model filename, the time span and an input table that describes the inputs in
function of sample time. The function then generates the outputs. Read example_sim.m for an example of
implementation. By executing this simulation file, you can see if the previous model example works as
expected.

2.1.6 Build model with Real-Time Workshop

Finally, build the model with Real-Time Workshop from you Simulink file.

Go to Tools-> Real-Time Workshop-> Build Model (likewise Ctrl+B or build icon ).
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If no error is detected, the building process appears in the MatLab command window. Warnings are also
displayed there. In the example, warnings tell you that the Discrete Zero-Pole parameters will be set constant
(correspond to the block comments in Annexe B).

Command Window

-aExtModeTransport=0 i
-aRTWCAPISighals=0

—aRTWCAPIParams=0

—aGenerateASAPZ=0

—ploooo

### Loading TLC function libraries

###f Initial pass through model to cache user defined code

###f Caching model source code
### Uriting header file exswple types.h
###f Uriting header file example.h

H## Uriting source file exsmple.c

### Uriting header file example private.h
### Uriting header file rtmodel.h

### Uriting source file example data.c

### Uriting header file rt_nonfinite.h

### Uriting source file rt_nonfinite.c

### TLC code generation complete.

#H## Creating example.mk from C:\Program Files)MATLAE7O4%\rtw'chgrthgrt

H### Successful completion of Real-Time Workshop build procedure for n
x| v

Figure 11: Real-Time Workshop build process of the example

A successful build of your Simulink system creates a new directory of name model_grt_rtw (model being your
Simulink file). The files inside that directory will then be used by the SimulinkToSR converter to implement the
system onto a Signal Ranger DSP board.
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2.2 Conversion and implementation with SimulinkToSR interface

The SimulinkToSR converter has the task to convert the Real-Time model created in Simulink and to implement

the system on the DSP.

Open the SimulinkToSR converter and follow the instructions.

Here is description of the interface:

3 SimulinkToSR

Target board SR2_analog_8

SimulinkToSR2 Version 2.2

Current Fs on DSP 0,832  kHz
Maximal Fs allowed 2012  kHz
Time usage 41 %

/| Convert with defauft IO
parameters (recommended)

‘ Convert ‘

RTW directory path

RTWexampIe\_ )
example_R14sp2 2011%
example_grt_rtw

4 [m| »

l Stop Execution l
.out file path
example_R14sp2_2011%

% example_grt_rtw\CodeSR2Y
example.out

Board Processing W

4 [m| »

| Save Configl | Load Configl

‘ STOP ‘

105 Interface Conversion Process . Registration .
| Variable #1
- . Continucus
Variable Selection Read
_sine_wave I ?6447E1 -
[wmebee 1[5
410,0000E+0 Reset (0)
| Variable #2
Variable Selection Continuous
| Read .
_sine_per T - - i
|2,0000E~+3
=
2000063 | [ Reset ()
| Inputs & Quputs
AIC Selection AIC Data
Qut2 T 16384 (116 format)

Graph Size

1024

20000 -
15000 -
10000 -

5000 -

0~
0

1,00E+3-]
7,50E+2-)

0

Overlay Plots

I
i

‘ ||ﬂ|| ‘ﬁ‘ ‘|f||
il

1
600
_Samples

1 I
400 600

Samples

1 1 1 1
200 400 600 800

Samples

_sine_wave m
_sine_per -

I
|\|\|
I

I

I ﬂ f| |'I I
|

I
800

Figure 12: SimulinkToSR interface

2.2.1

Convert button

By pressing on the Convert push button, you start the conversion process of the code generated from Real-
Time Workshop (under Simulink) to a .out file that can be implemented on the Signal Ranger DSP board.

The conversion process can be resumed through the following elements:

1- AIC parameters

2- Real-Time Workshop file

3- Sampling frequency check
4- Required files

5- Conversion Process textbox

2.2.1.1 AIC parameters

A first window appears if Convert with default 1O parameters checkbox is unchecked. This window allows
you to set the AIC parameters of the board, which are the 10s of the Signal Ranger DSP board.
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Figure 13: AIC parameters setting panel for SR1 and for SR2

You can set a gain to the AIC input and output with Input gain and Output gain. This is particularly useful to
enhance the ratio signal on noise (SNR) when the input signal is low. However, care should be taken when
applying gains. There is normally an equivalence between the analogue voltages on the AICs and the input
and output amplitudes in the simulink model. This correspondence is no longer valid when gains are used.
Let’s recall that dynamic ranges are normally (gains of 0 dB) of +/- 10 volts for the inputs and +/- 2 volts for
the outputs.

SR1

Switching the AIC parameters mode in «Simplified» or «Complete» position respectively to set AICs
individually or globally. You can set AICs “Normal”, “Analog loopback” or “Digital loopback” by using A/C cfg
parameter. Unless specific aims are intended, the “normal” option is recommended.

SR2

Each AIC of SR2 board contains 2 channels. The parameters will be set accordingly. Also, SR2 board exist
in different configuration that doesn’t contains the same number of AlCs. Therefore, only the existing AlCs
will be allow in the AIC selection menu. Once again default options are recommended unless specific aims
are intended.

2.2.1.2 Real-Time Workshop file

Once all required files are found, SimulinkToSR converter asks you to identify the Real-Time Workshop
directory built from Simulink model (RTW directory path). This directory can normally be found in the
Simulink model directory and the name should be in the format model_grt_rtw.
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-

Open the model directory generated by Real-Time Workshop and press Select E]

Regarder dans : | (L) example_art_rtw v o ¥ * &
@examp\ec
/J @examp\e.h
Recent @examp\e.mk

example_data.c

B IE example_private b

g @ example_types.h
HEa E1 modelsources. Ext
IE rkmodel.h

_,/ rbw_proj.tmw

Mes documents
J
%8
Poste de travail
.

Favoris iéseau | |

MNom du fichier | madel_art_rtw it
Fichiers de type : | Al Files 77 |
Select |

Figure 14: Selection of Real-Time Workshop directory in the example

2.2.1.3 Sampling frequency check

If the Simulink “fixed step size” does not match one of the available sampling frequencies on the DSP, a
window appears. A warning is displayed and we suggest you the closest frequency that would match the
frequency set in Simulink. To disable this window, it is recommended to set the “fixed step size” in Simulink
to an allowed value (see section 2.1.1).

@ 5 i
[ s4Select Sampling Frequency Select Sampling Frequency

Warning : Simulink frequency not allowed Warning : Simulink frequency not allowed

Results will differ from the Matlab simulation if the sampling frequency Results will differ from the Matlab simulation if the sampling frequency

set in the Simulink model {via fired step size) does not correspond to set in the Simulink model (via fixed step size) does not correspond to
the frequency choices allowed here for the DSP. the frequency choices allowed here for the Signal Ranger mk2 DSP.
Fixed step allowed are  N/21700 where N={1,2, 3, .., 32} Fixed steps allowed are listed in 'DSP Sampling Frequency' menu below.
According to Simulink (simulation parameters -- = fixed step size) According to Simulink {(simulation parameters - fixed step size)
Sampling Frequency (HZ_)_> Sampling perind (£} Sampling Frequency (Hz) Samnpling period (5}
3,9455E+3 - Z,5346E-4 334,615 == 1,1982E-3
Select frequency I f
DSP Sampling and press 0K DSP Sampling Select frequency

and press DK

) Frequency - Frequency
£ QK |
) 4340.0Hz 832,298Hz  |w

Figure 15: Frequency check window for an invalid Simulink sampling frequency for SR1 and for SR2

2.2.1.4 Required files
The first time the SimulinkTOSR program runs on your computer, you may be asked to provide some files.

In order to respect copyrights of third software companies, you need to provide some files to the current
program. The SimulinkToSR program normally copies Texas Instruments files in 'IncludeSources\T|_files'
directory and MatWorks files in 'IncludeSources\MatWorks_files' directory. The program will fail if some files
are missing. The complete file list can be found in Annexe D.

MatWorks files should not cause any problem because they belong in majority to Real-Time Workshop,
which you used previously.

Texas instruments files are part of the Code Composer Studio that should be installed on your computer. If
you do not possess the Tl files, go to Annexe A on How to get Code Composer Studio.

p. 13
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2.2.1.5 Conversion Process textbox

During all the conversion process, the current operation is displayed in the textbox of the Conversion
Process tab (figure 16). Errors and warnings are also displayed in this textbox.

As the process completes, a led appears at the bottom of the window. A green led indicates that the
conversion is successful and a red led indicates that the conversion failed.

If no mistake occurred, you are invited to load and execute the program on the DSP.

I8 SimulinkToSR ' o ' ’ L 2% |

I0sInterface  Conversion Process | Registration I

SimulinkToSR2 Version 2.2

Target board |SR2_analog 8 STAR NG CONVERSION... =
Current Fs on DSP 0,832 | kHz Opening directory generated by Real-Time Workshop... ..0K
Worimal = allrared 2012 | kHz RTW model dlrector}r sele.cted.ls: . ;
C:\SoftdB_work!\Projets\SimulinkTo5R\SimulinkTo5R_v2_1_1\RTWexample\example_R14sp2_2011%
Time usage 41 % example_grt_rbw
[#] Convert with defauit 10 Extracting infe from model... ..0K

parameters (recommended)

Converter mode:

l Convert ‘ -» Signal Ranger mk2 (SR2) & channels - TMSC320C5502
RTW directory path > MathWorks g 33
RTWexample\ & Checking the n ... ...0K
example R14sp2 2011\ £ Checking the nul

example_grt_rtw i Checking the nul K

m

Searching Texas E
Searching MatWi
Creating a new d ¥ g g
Copying files from IncludeSources' to CodeSignalRangert.., ..OK
Copying Real-Time workshop files te final directory ..OK
Compiling all .c files in model directory... ..0K
Compiling real time workshop library files... ..0K
Creating real time workshop library... ...0K

Creating dataprocess.c file... ...OK
— Compiling dataprocess.c ... ..0K

K

Linking project... ...

l Start Execution

«out file path

| example_R14sp2_2011\

% example_grt_rtw\CodeSR2Y
. eample.out

4 [m] »

[save Config] [ Load Config] CONVERSION COMPLETED!

STOP Successful ":J

Figure 16: Conversion Process

L

Because code size is limited by the DSP, the linker may display an allocation error if the code size is larger
than the limit.

2.2.2 Start/Stop Execution button

By switching the Start/Stop Execution button, you can start and stop the execution of DSP program. Therefore,
.out file is reloaded every time you press Start Execution and processing is interrupted when you press Stop
Execution. Reading and writing obviously end when the execution stops.

Under the execution button, a rectangular led lets you know if the DSP board is properly running or not
according to a green or a red light.

2.2.3 Processing Time Usage

A higher sampling frequency on the DSP means that it can process fewer operations in one cycle. However, the
relation between design complexity and processing time is not obvious. Therefore, the interface displays the
rate of time usage. In fact, Time Usage indicates its higher value since the last time the code has been
executed. This way, you can better judge if the timing requirement is critical and if you can increase the
sampling frequency.
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2.2.4 Save and Load configuration

A normal use of the program requires converting your Simulink model at least once before loading it on the
board. You can then set a few parameters to display the variables of interest. You might find useful the Save
Config and Load Config buttons in order to start with the configuration of previous session. Doing so, you can
start the execution without converting your model again.

2.2.5 Variable #1 and Variable #2 interfaces
The Variable #1 and Variable #2 of the IOs Interface tab allow you to display and modify their value on the DSP.

By using Variable Selection menu, you can select a variable you wish to display or modified. An underscore
precedes the name of your MatLab variable names.

The program supports Simulink arrays and matrixes. Therefore, an Index can be applied on the variable DSP
address if you need to access elements of a vector or a matrix variable. The Index and Length parameters will
be visible only when the variable is really an array. Particular attention should be taken while using index on
matrix variable. Once on the DSP, matrixes are converted in vectors by appending columns beginning by the
leftmost one.

By pressing Read push button, you read a single sample of the selected variable. You can alternatively read in
continuous by switching on the Continuous Read button. Read values are displayed on both the Read Data and
on the plot on the right.

By pressing Write push button, you write the Write Data value to the selected variable. You can alternatively
use the Set and Reset button to directly write 1 or 0 respectively.

2.2.6 Inputs & Outputs interface

The Inputs & Outputs interface of the IOs Interface tab allows you to display the numeric value of the AlCs (the
inputs and outputs of the board).

By using AIC Selection menu, you can select the channel you wish to display. Let's remember that port
numbers of Inport and Outport Simulink blocks are directly related, in ascending order, to the available 10s of
the board.

Read values are displayed on both the AIC Data and on the plot on the right®. Since AIC are represented in 16
bits signed format, the values range from —32768 to 32767. The numeric range normally matches the analogue
ranges, respectively of +/- 10 volts for AIC inputs and +/- 2 volts for AIC outputg.

2.2.7 Signal waveforms
Three graphics are showed on the /Os Interface tab; Variable #1, Variable #2 and one IO.

Variables 1 and 2 can be displayed in overlay mode or stack mode by switching up or down the button above
the plots.

The number of displayed samples can be adjusted through the Graph Size parameter. lts value can vary from 1
to 1024 samples.

Note that data are read in an asynchronous sampling period of 10 ms or higher. Therefore, the waveforms on
the interface will not necessarily represent the exact waveforms the DSP generates. Also, trying to link samples
with time will not be precise.

2.2.8 Stop button

Press the Stop push button to end the program. If the code was running on the DSP, it will not be interrupted.

® Analogue ranges will differ if you use gains on the AIC parameter panel during the conversion process.
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Annexe A: How to get Code Composer Studio

In order to respect Texas Instruments copyrights, you need to provide Code Composer Studio files to our
program. The SimulinkToSR program normally copies automatically the required files in the
'IncludeSources\T|_files' directory.

Let’s first tell you how to get the required Tl files:

1-

3-

Purchase a DSP Starter Kit (DSK). This will give you a version of Code Composer Studio that will
work indefinitely with your DSK. It will also allow you to provide the necessary files for our
Simulink/Signal Ranger converter. Use the link below to purchase a TMS320VC5416 DSK, if you
would like to take this option.

TMS320VC5416 DSP Starter Kit (for use with our Signal Ranger DSP board (SR1) ) :

http://www.spectrumdigital.com/product info.php?cPath=24 64&products id=100&osCsid=5a15
7cecae4a7338adf02278de155432

TMS320VC5510 DSP Starter Kit (for use with our Signal Ranger MK2 board (SR2) ):
http://www.spectrumdigital.com/product info.php?cPath=24 64&products id=108&o0sCsid=5a15

7cecae4a7338adf02278de155432

Download your 120-day trial evaluation tools for C5000 DSPs. It includes a version of Code
Composer Studio. It will also allow you to provide the necessary files for our Simulink/Signal
Ranger converter.

Here is the hyperlink to the Code Composer Studio™:
http://focus.ti.com/docs/toolsw/folders/print/ccstudio.htmi

Purchase the full version of Code Composer Studio.
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Annexe B: List of supported Simulink blocks

Here is the list of the blocks tested so far with the SimulinkToSR converter. Non-enumerated blocks are
not guaranteed to work.

Unless otherwise specified all block parameters can be modified in real-time once implemented. To
achieve that, set block parameters with “ExportedGlobal” variables, which have to be predefined in

MatLab workspace (see sections 2.1.3 and 2.1.5 for more details)

Group Block name Functionality Comments
1 = Perfect
2 = OK with limitations
3 = To come in further version
4 = Not supported by SimToSR
5 = Not supported by RTW
Simulink/Continuous All Blocks of group 5 Not Supported by RTW becauce Continuous
Simulink/Discontinuities  |Backlash 2 "InitialOutput" parameter cannot be controlled in real-
time (RTW limitation)
Simulink/Discontinuities  |Coulomb & Viscous 1
Friction
Simulink/Discontinuities  |Dead Zone 1
Simulink/Discontinuities  |Hit Crossing 1
Simulink/Discontinuities  |Quantizer 1
Simulink/Discontinuities  |Rate Limiter 4 This block generates a new sample time of 0
(continuous) which is impossible to achieve.
Simulink/Discontinuities  |Relay 1
Simulink/Discontinuities  |Saturation 1
Simulink/Discrete Discrete transfer function 1
Simulink/Dicrete Discrete poles-zeros 2 Parameters cannot be controlled in real-time (RTW
limitation)
Simulink/Dicrete Discrete filter 1
Simulink/Dicrete Discrete state-space 1
Simulink/Dicrete Discrete-Time Integrator 1
Simulink/Dicrete Memory 1
Simulink/Dicrete Unit Delay 1
Simulink/Math Operations |Abs 1
Simulink/Math Operations |Algebraic constraint 5 Real-Time Workshop Error: Real-Time Workshop does
not support models with algebraic loops.
Simulink/Math Operations |Assignment 1 Rows and columns elements have to be external if it is
desired to modified them in real-time.
Simulink/Math Operations |Bitwise Logical Operator 1
Simulink/Math Operations |Combinatorial Logic 2 Do not modify "truth table" parameter dynamically.

Simulink/Math Operations

Complex to Magnitude-
Angle

Simulink/Math Operations

Complex to Real-Imag

Simulink/Math Operations

Dot Product

\
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Simulink/Math Operations

Gain

Simulink/Math Operations

Logical Operator

Simulink/Math Operations

Magnitude-Angle to
Complex

Simulink/Math Operations

Math Function

Are OK : exp, 10”u, magnitude”2, square, sqrt, pow,
conj, reciprocal, mod, transpose, hermitian,hypot

Not supported yet: log, log10,rem

Simulink/Math Operations

Matrix Concatenation

Simulink/Math Operations

Matrix Gain

Simulink/Math Operations

MinMax

Simulink/Math Operations

Polynomial

Simulink/Math Operations

Product

Simulink/Math Operations

Real-Imag to Complex

Simulink/Math Operations

Relational Operator

Simulink/Math Operations

Reshape

Simulink/Math Operations

Rounding Function

Simulink/Math Operations

Sign

Simulink/Math Operations

Slider Gain

Simulink/Math Operations

Sum

Simulink/Math Operations

Trigonometric Function

Are OK : sin, cos, tan, asin, acos, atan, cosh, sinh, tanh,
atan2

asinh, acosh, atanh are not supported are not
supported by ANSI-C (do not use)

Simulink/Ports & Enable

Subsystems

Simulink/Ports & Enabled Subsystem
Subsystems

Simulink/Ports & Enabled and Triggered
Subsystems Subsystem
Simulink/Ports & If

Subsystems

Simulink/Ports & If Action Subsystem
Subsystems

Simulink/Ports & In1

Subsystems

Simulink/Ports & Outl

Subsystems

Simulink/Ports & Subsystem
Subsystems

Simulink/Ports & Trigger

Subsystems

Simulink/Ports &
Subsystems

Triggered Subsystem

Simulink/Signal Attributes

Data type conversion
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Simulink/Signal Routing

Data Store Memory

Set properties to "ExportedGlobal" to access data
dynamically in SimulinkToSR interface

Simulink/Signal Routing

Data Store Read

Simulink/Signal Routing

Data Store Write

Simulink/Signal Routing

Demux

Simulink/Signal Routing

Multiport Switch

Simulink/Signal Routing  |Mux 1

Simulink/Signal Routing  |Selector 1 The “indices” parameters have to be external in order to
be modified in real-time.

Simulink/Signal Routing  |Switch 1

Simulink/Sinks Display 1 Simulation tool only... ignored by RTW

Simulink/Sinks Outl 1 See also Simulink/Ports & Subsystems

Simulink/Sinks Scope 1 Simulation tool only... ignored by RTW

Simulink/Sinks Terminator 1

Simulink/Source Band limited white Noise 4 Not supported

Simulink/Source Chirp Signal 4 Not supported

Simulink/Source Clock 5 Not supported

Simulink/Source Constant 1

Simulink/Source Digital clock 4 Not supported

Simulink/Source From workspace 4 Not supported

Simulink/Source From file 4 Not supported

Simulink/Source Ground 1

Simulink/Source In1 1 See Simulink/Ports&Subsystems/In1

Simulink/Source Pulse generator 1 Select "Sample based" in the "Pulse type" parameter of
the block

Simulink/Source Ramp 4 Not supported

Simulink/Source Random Number 4 Not supported

Simulink/Source Repeating Sequence 4 Not supported

Simulink/Source Signal generator 4 Not supported

Simulink/Source Signal builder 4 Not supported

Simulink/Source Sine wave 1 Select "Sample based" in the "Sine type" parameter of
the block

Simulink/Source Step 4 Not supported

Simulink/Source Uniform Random Number 4 Not supported
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Annexe C: List of frequency supported by the SR2 board

Values are in hertz.

286.102
290.644
295.331
300.173
305.176
310.020
310.348
315.020
315.699
320.184
321.238
325.521
326.974
331.038
332.164
332.919
336.746
337.522
339.084
342.654
343.055
345.482
348.772
352.126
354.684
355.114
357.715
359.030
360.799
361.690
363.485
366.211
367.129
368.514
369.444
373.685
375.601
380.479
381.470
381.967
382.966
387.525
388.553
389.586
390.625
393.775
394.837
395.369
398.055
398.597
400.231
402.430
406.901

409.747
410.320
413.798
415.559
416.149
417.334
418.527
420.932
422.754
424.592
425.209
425.827
427.068
428.317
429.573
433.386
434.028
435.965
436.615
441.883
443.892
445.241
446.599
450.721
451.416
452.112
454.215
454.920
457.764
459.199
459.920
460.643
465.030
467.255
469.501
472.530
475.599
476.372
478.707
479.491
480.277
481.856
484.246
486.659
488.281
489.914
493.213
494.880
496.557
498.246
500.801
502.519
505.119

508.626
510.399
512.183
513.980
516.700
519.448
522.226
523.158
524.094
525.034
527.872
530.740
532.670
533.641
536.573
538.545
542.535
543.541
549.660
550.693
551.730
5562.771
554.865
558.036
561.243
563.401
565.577
566.671
567.769
571.089
572.205
574.449
577.848
578.990
581.287
585.937
590.663
591.856
593.054
595.465
597.895
600.346
602.816
605.307
609.083
610.352
614.190
615.481
619.384
620.697
623.338
626.002
630.040

631.398
634.131
636.889
638.276
642.475
643.887
649.598
651.042
653.948
659.840
662.825
664.328
665.838
673.491
675.043
678.168
681.323
682.911
686.109
690.964
692.598
697.545
700.882
704.252
707.654
709.367
714.558
718.061
719.825
721.598
723.380
726.970
732.422
734.258
739.820
747.369
751.202
757.025
760.958
762.939
770.970
775.050
777.105
779.172
781.250
783.339
787.550
789.673
791.807
793.953
796.111
800.461
804.859

807.076
813.802
820.641
827.595
832.298
834.669
837.054
841.864
849.185
851.653
854.136
856.634
859.146
861.673
866.771
871.931
879.786
887.784
890.483
893.197
901.442
904.225
909.841
915.527
918.397
921.285
930.060
939.002
945.060
951.197
957.414
960.553
963.713
973.318
976.562
979.829
986.427
989.759
993.114
996.492
1010.237
1017.253
1020.797
1024.366
1027.961
1038.896
1046.317
1050.067
1061.481
1065.341
1073.146
1077.091
1085.069

1101.386
1105.542
1109.730
1122.486
1126.803
1131.153
1135.538
1144.409
1148.897
1157.979
1162.574
1171.875
1181.326
1186.108
1190.930
1195.791
1200.692
1205.633
1210.615
1220.703
1230.961
1241.393
1246.676
1252.003
1262.796
1268.263
1273.777
1284.951
1302.083
1307.896
1319.679
1325.650
1331.676
1350.086
1356.337
1362.645
1381.928
1395.089
1401.764
1408.504
1415.308
1429.116
1436.121
1443.196
1464.844
1479.640
1494.739
1502.404
1525.879
1541.941
1550.099
1558.344
1566.678

1575.101
1583.615
1592.221
1600.922
1609.718
1627.604
1655.191
1664.595
1674.107
1683.728
1703.307
1713.268
1723.346
1733.543
1743.862
1775.568
1786.395
1808.449
1819.682
1831.055
1842.571
1878.005
1890.121
1902.394
1914.828
1927.426
19563.125
1979.519
1992.985
2020.474
2034.505
2048.733
2077.793
2092.634
2122.962
2154.182
2170.139
2202.773
2219.460
2253.606
2271.076
2288.818
2325.149
2343.750
2362.651
2381.860
2401.383
2421.229
2441.406
2461.922
2482.786
2504.006
2525.593

2547.554
2569.901
2615.792
2639.358
2663.352
2712.674
2763.856
2790.179
2817.007
2872.243
2929.687
2959.280
2989.477
3051.758
3083.882
3116.689
3150.202
3184.443
3219.437
3255.208
3329.190
3367.457
3406.613
3446.691
3487.723
3572.790
3616.898
3662.109
3756.010
3804.789
3854.852
3906.250
3959.037
4069.010
4185.268
4245.924
4308.364
4438.920
4507.212
4577.637
4650.298
4725.302
4802.766
4882.812
4965.572
5051.185
5139.803
5231.585
5326.705
5425.347
55627.712
5634.014
5744.485

5859.375
5978.954
6103.516
6233.378
6368.886
6510.417
6658.381
6813.227
6975.446
7145.579
7324.219
7512.019
7709.704
7918.074
8138.021
8370.536
8616.728
8877.841
9155.273
9450.605
9765.625
10102.371
10463.170
10850.694
11268.029
11718.750
12207.031
12737.772
13316.761
13950.893
14648.437
15419.408
16276.042
17233.456
18310.547
19531.250
20926.339
22536.058
24414.062

\
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Annexe D: List of files required for the converter

The SimulinkToSR converter will be looking for the following files related to your Matlab version.

MatWorks files needed with Matlab 6.5 (R13)
Default path: CAMATLABG6p5\

MatWorks files needed with Matlab 7.0 (R13)
Default path: C:\Program Files\MATLAB704\

riw\c\libsrc\rt_mxclassid.h
rtw\c\libsrc\rt_logging.h
rtw\c\libsrc\rtlibsrc.h
rtw\c\libsrc\rt_matmultrr_dbl.c
rtw\c\libsrc\rt_matmultandincrr_dbl.c
rtw\c\libsrc\rt_atan2.c
rtw\c\libsrc\rt_hypot.c
rtw\c\libsrc\rt_zcfen.c
extern\include\tmwtypes.h
simulink\include\simstruc_types.h

riw\c\libsrc\rt_mxclassid.h
rtw\c\libsrc\rt_logging.h
rtw\c\libsrc\rtlibsrc.h
rtw\c\libsrc\rt_matmultrr_dbl.c
rtw\c\libsrc\rt_matmultandincrr_dbl.c
rtw\c\libsrc\rt_atan2.c
rtw\c\libsrc\rt_hypot.c
rtw\c\libsrc\rt_zcfcn.c
extern\include\tmwtypes.h
simulink\include\simstruc_types.h
simulink\include\rtw_matlogging.h
simulink\include\rtw_extmode.h
simulink\include\rtw_continuous.h
simulink\include\rtw_solver.h
simulink\include\sysran_types.h
simulink\include\simstruc.h

The SimulinkToSR converter will be looking for the following files related Code Composer Studio from TI.
Files will differ whether you are using SR1 or SR2 board.

Texas Instruments Files needed for SR1 board

Default path...

CCS2: C:\ti\c5400\cgtools\

CCS3: C:\CCStudio_v3.3\c5400\cgtools\

CCS4: C:\Program Files\Texas
Instruments\ccsv4\tools\compiler\c5400\

Texas Instruments Files needed for SR2 board

Default path...

CCS2: C:\ti\c5500\cgtools\

CCS3: C:\CCStudio_v3.3\c5500\cgtools\

CCS4: C:\Program Files\Texas
Instruments\ccsv4\tools\compiler\c5500\

cgtools\lib\rts.lib
cgtools\bin\acp500.exe
cgtools\bin\ar500.exe
cgtools\bin\asm500.exe
cgtools\bin\cg500.exe
cgtools\bin\cl500.exe
cgtools\bin\Ink500.exe
cgtools\include\float.h
cgtools\include\limits.h
cgtools\include\linkage.h
cgtools\include\math.h
cgtools\include\string.h

cgtools\lib\rts55.lib
cgtools\bin\acp55.exe
cgtools\bin\ar55.exe
cgtools\bin\asm55.exe
cgtools\bin\cg55.exe
cgtools\bin\cl55.exe
cgtools\bin\Ink55.exe
cgtools\bin\masm55.exe
cgtools\include\float.h
cgtools\include\limits.h
cgtools\include\linkage.h
cgtools\include\math.h
cgtools\include\mathf.h
cgtools\include\mathl.h
cgtools\include\string.h
cgtools\include\unaccess.h
cgtools\include\access.h

\




